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Heirloom Holly Border with MasterWorks III 
 

 
I. Trace Backdrop 

ON THE HOME TAB 

A. Open a New Page  and turn on 3D . 

B. Left click on the top of the Backdrop tool . 

1. In the Artwork folder there is an image called Holly.  

a) C:/Designer’s Gallery/ MasterWorks III/Artwork/Holly.wmf 

b) Select Holly.jpg and click Open  

2. Left click  on the zoom tool to zoom to fit. 

C. Use the Magic Wand  to trace the three leaves. 

1. Select a light green color  in the color palette. 

2. Left click on Artwork   to open the menu 

3. Select the Magic Wand  from the Artwork menu 

4. Left click on each leaf in the backdrop picture 

5. Note in the Sequence View that we now have artwork for the leaves. 

D. Instead of tracing the backdrop, we will use the circle tool to draw the berries. 

1. Select a pale pink color  in the Sequence View 



Heirloom Holly Border with MasterWorks    

                                                                                       
© 2012 Tacony Corp, all rights reserved  

 
  

2 

2. Left click on Artwork  to open the menu 

3. Select the Ellipse . 

4. Hold down the Control key on your keyboard while you click and drag to draw the 
circle.   

a) The Control key will force the tool to draw a perfect circle instead of an oval. 

5. Draw just one circle using one of the berries on the backdrop image as a guide. 

a) Note: Once we have created one perfect eyelet we will copy and paste for the 
other two berries. 

E. Turn off the backdrop 

1. Left click on the bottom of the Backdrop tool  

2. Left click to remove the checkmark from Show Backdrop 

 

II. Slice Leaves  
A. Slicing the leaves will allow us to put a different 
stitch direction on each half of the leaf. 

B.  Note that in the Sequence View the artwork for 
the leaves that were traced is visible. 

1. Left click on the plus sign at the left of 
the three leaves and the list opens to show 
each leaf individually. 

2. The leaves are labeled Artwork because 
no stitches have been assigned yet. 

C. Open the Navigator box 
     ON THE VIEW TAB 

1. Left click on the View Tab 

2. Left click to place a checkmark in the box for Navigator 

3. Click and drag on the title bar at the top of the 
Navigator box and move it to a convenient location that will not block your view of the holly 
artwork or the Sequence View  

4. In the Navigator box will you will be able to: 

a)  Zoom in on the individual leaves  

b) Pan from one leaf to the next without changing the zoom 

c) Still have a visual of the entire design even though you are zoomed in on one 
area.  

5. Move the slide on the Navigator box to the right to zoom in on the lower left leaf 

a) As you move the slider the red box in the Navigator changes size and you are 
zoomed in on the design page 

b) Place your cursor over the red box and the cursor changes to a hand and you 
will be able to click and drag the red box so the leaf is centered within that box 



Heirloom Holly Border with MasterWorks    

                                                                                       
© 2012 Tacony Corp, all rights reserved  

 
  

3 

c) The area inside the red outline in the Navigator will be displayed on the design 
page. 

D. Select the lower left leaf 
      ON THE HOME TAB 

1. Left click on the Home Tab 

2. Select the leaf 

a) You can select the leaf either by clicking right on the green outline of the leaf 
on the design page.  

(1) If you left click on the empty space in the center of the leaf it will not be 
selected. 

b) Or select the leaf by left clicking on it in the Sequence View.  

(1) This may be easier since you don’t have to click right on the outline of 
the leaf.   

(2) Just left click to select it from the list in the Sequence View 

E. The slice tool is used to split the leaf into two sections 

1. Left click on the bottom of the Reform tool  to open the 
menu 

2. Select Slice on the Reform tool menu 

F. Slice the leaf 

1. Left click on the Bezier point at the tip of the leaf and continue 
to hold the left mouse button down 

2. Drag across the leaf to the Bezier point at the top of the center 
gap of the leaf. 

3. Left click on the Bezier point at the top of the leaf gap 

4. Right click to finish the slice. 

G. Check the Sequence View and you will find that now instead of one leaf you have two half 
leaves. 

1. The Slice tool automatically breaks the 
object apart when the slice is complete. 

H. Split the second leaf 

1. Move the red highlighted box in the 
Navigator box so it is around the second leaf. 
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2. Select the second leaf 

3. Left click on the bottom of the Reform tool  to open the menu 

4. Select Slice on the Reform tool menu 

5. Left click on the Bezier point at the tip of the leaf and continue to hold the left mouse 
button down 

6. Drag across the leaf to the Bezier point at the top of the center gap of the leaf. 

7. Left click on the Bezier point at the top of the leaf gap 

I. Split the third leaf 

1. Move the red highlighted box in the Navigator 
box so it is around the third leaf. 

2. Select the third leaf 

3. Left click on the bottom of the Reform tool  
to open the menu 

4. Select Slice on the Reform tool menu 

5. Left click on the Bezier point at the tip of the leaf 
and continue to hold the left mouse button down 

6. Drag across the leaf to the Bezier point at the top 
of the center gap of the leaf. 

7. Left click on the Bezier point at the top of the leaf gap 

8. Note that in the Sequence View you now have six leaf halves instead of three leaves. 

a) When we apply stitches to the half leaves, we will be able to set a different 
stitch direction for each of those areas. 
 

III. Leaves 

A. Left click  on the zoom tool to zoom to fit. 

1. The zoom is changed on the design page and in the Navigator box 

B. Select all six of the half leaves.  

1. The easiest way to do this is in the Sequence View 

a) Select the light green color   in the 
Sequence View and it will select all six half leaves. 

2. Left click Apply Stitches  to open the menu 

3. Left click to select Standard  from the Apply Stitches menu 
C. Copy and Paste to add an outline to the leaves 

1. To select all of the leaves, left click on the color green 

 in the Sequence View. 
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a) All of the leaf sections will be selected and the circle for the eyelet berry will not 
be selected. 

2. Right click and select Copy from the pop up menu. 

3. Right click and select Paste from the pop up menu. 

4. If you check the Sequence View, you will see that 
there are two sets of leaves and the second set that 
you just created is selected. 

a) On the design page it looks like the pattern 
was not changed by the Copy and Paste. 

b) The second set of leaves was pasted 
exactly on top of the first set, so when we 
change that second set of leaves to an outline 
stitch, the outline will be perfectly positioned. 

5. Left click on Apply Stitches  to open the menu 

6. Left click to select Run in the Apply Stitches menu to change the stitching in 
the second set of leaves and create an outline around those leaves. 

7. In the Properties box:  

a) Change the stitch length to 2.0 

b) Change the Stitch type to Double Run  

c) And click Apply  
 

IV. Re-Sequence Leaves  
A. Re-Sequencing the leaves and their outlines can give us a design that will stitch more quickly 
and smoothly 

B. Run the Sewing Simulator to see how the design will sew. 

1. Note that currently the fill sections of the leaves sew first and then all of the leaf 
outlines are sewn. 

2. Since the leaf outlines are being sewn in the same color as the fill, they could be sewn 
at the same time. 

a) The design would stitch more smoothly if each leaf section had both the fill and 
outline sewn before the machine moves on to 
the next leaf section.   

C. Right click on any item in the Sequence View and select 
Expand All from the pop up list. 

2. All of the colors will be opened up so you can see 
each leaf section. 

3. It is the same thing you would have if you went 
down the list and clicked on all the little plus signs to 
the left of each color. 

D. We cannot see both the fill areas and the outlines of the 
leaves in the Sequence View because the list is longer than 
the size of the Sequence View box 

1. Expand the size of the Sequence View by tabbing it 
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2. Left click and drag the Title bar of the Sequence View until you see the tab controls 
appear as shown in the picture at the right 

3. Continue to hold the left mouse button down and move to where you can left click on 
the center control in the tab controls 

4. When you left click on that center icon, the Sequence View will be pinned to the right 
margin of the page and will be extended to use the entire length of the page on the right 
side of the computer screen. 

a) Now you will be able to see both the fill areas and the outlines of the leaves at 
the same time 

E. Click and drag each outline and drop it under the leaf it belongs to. 
 

V. Stitch Direction Plus Start And End Points 
A. Just a little more fine tuning and the leaves will be ready to stitch out perfectly. 

1. Slicing the leaves gives us the opportunity to adjust the angle of the stitches on each 
half of the leaf  

a) Using different stitch angles creates a change in texture and adds dimension to 
the leaf 
b) It also creates subtle shading because light reflects differently and your eye 
sees the color as being a slightly different color. 

2. We can also improve how the design stitches by setting the starting point and ending 
points so the end point of each step places us at the closest spot possible to the starting 
point of the next step. 

B. Select the first leaf section at the top of the Sequence View 

1. Left click on Reform  

2. The pair of black beads with a string between them controls the stitch direction. 

3. Click and drag the black beads to set the stitch direction. 

a) When choosing a stitch direction for fill stitches, pretend you have a crayon in 
your hand.   

b) Set the stitch direction in the same direction you would use if you were going to 
color that area with the crayon. 

4. Either left click Apply  in the Properties box, or right click on the design 
page to apply the change. 

C. Set the Start and Stop points for the fill. 

1. Click and drag the green Start point to the leaf point at the bottom of the leaf. 

2. Click and drag the red Stop point to the point at the tip of the leaf. 

a) This will cause the stitching to finish at a spot where it is closest to the other 
half of the leaf. 

3. Click Apply  or right click on the design page to apply the change. 

D. Select the outline of the same leaf section in the Sequence View 

1. Left click on Reform  

2. Move both the green Start point and the red Stop point to the point at the tip of the 
leaf. 
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3. Click Apply  

E. Select the fill area for the other half of the leaf 

1. Left click on Reform  

2. Adjust the black beads 

3. Move the green Start point to the point at the end of the leaf  

4. Move the red Stop point to the point at the base of the leaf. 

5. Click Apply  or right click on the design page to apply the change. 

F. Select the outline for the second half of the leaf 

1. Left click on Reform  

2. Move both the green Start point and the red Stop point to the point at the base of 
the leaf. 

3. Click Apply  or right click on the design page to apply the change. 

G. Repeat for each leaf 

1. Run the Sewing Simulator to see how the leaves will sew. 

  

VI. Eyelet Berries 
A. How is an eyelet sewn? 

1. Traditionally an open eyelet is formed by sewing tiny straight stitches around the place 
where the hole is to be. 

2. Then the hole is cut. 

3. And finally satin stitches are sewn to cover the raw edge of the hole. 

B. The stitch effect in MasterWorks that will sew straight stitches and then cover them with a 

satin stitch is the Appliqué  stitch. 

1. Select the berry ellipse 

2. Left click on Apply Stitches  to open the menu 

3. Select Appliqué  and you will have an instant eyelet! 

C. To see how the eyelet will sew: 

1. Right click on the Appliqué in the Sequence View and select Hide Other from the pop 
up menu.  

2. The Ghost  effect to see the areas of the design that are no longer being “shown”. 
ON THE VIEW TAB 

a) Left click on the View tab 
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b) Left click on Ghost  and the holly leaves will be displayed as a white 
ghosted image. 

c) While the leaves are ghosted you will not be able to select them, edit them or 
move them.   

d) And when you run the Sewing Simulator, the leaves will not stitch out, so you 
will be able to see how the eyelet stitches without waiting for the leaves to stitch 
first! 

(1) This is a great time-saver when you are editing.  
ON THE HOME TAB 

3. Left click on the Home tab 

4. Run the Sewing Simulator to see how the eyelet stitches.  

5. Turn the leaves back on  

a) Right click on any object in the Sequence View 

b) Select Show All from the pop up menu 

D. Adjust the properties of your eyelet 

1. Select the eyelet 

2. Left click on the Properties tab at the lower right if you have tabbed the panes. 

3. Stitch length 

a) This is the length of the straight stitches that sew under the satin stitch. 

b) Change the stitch length to 1.5 

4. Appliqué width is the width of the satin stitch 

a) Change the appliqué width to 3.0 

5. Click Apply    

E. If you want to change the color 

1. Select the berry and click on rose pink  in the color palette. 

2. A pop up box will ask if you want to change color 1, color 2, or color 3. 

3. Select color 3. 
 

4. If desired, you can also use the selection handles around the eyelet to re-size the 
eyelet so it is the perfect berry size. 

F. Note that the appliqué stitching is larger than the circle we drew for the berry 

1. If you select the Reform the outline of the original artwork will be visible 

a) The applique stitch effect makes things bigger than the original outline of the 
artwork. 

(1) The straight stitches are placed on that original outline. 

(2) The satin stitch is placed so half of the satin stitch is inside the straight 
stitch and half is outside the straight stitch. 

(3) That half of the stitch that is outside makes the area bigger than it was 
when it was outlined with straight stitches! 

G. It is also important that the center opening of the eyelet should match the size of hole that 
your awl is going to cut. 

1. Use your awl to cut a hole on a scrap of fabric and then measure the resulting hole. 
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a) The awl that I am using cuts a 3mm hole. 

b) When measuring very small areas like the eyelet hole it is easier to measure in 
millimeters instead of fractions of an inch 

2. To change your MasterWorks to measure in millimeters 

a) Right click any place on the ruler at the edge of the design page 

b) Select Metric from the pop up menu 

3. Left click on Ruler  

4. Measure the opening in the center of the eyelet by clicking and dragging across the 
hole with the ruler. 

5. The measurement will be shown on the Status Line in the lower left corner of the 
screen. 

H. By re-sizing the eyelet, the hole in the center can be made smaller so it will match the size of 
the hole made by the awl. 

1. Left click on the Select  

2. Click and drag the corner handles on the eyelet to make the eyelet smaller 

3. Left click on the Ruler  and re-measure the center of the eyelet.  

4. Repeat steps 1 through 3 until the center of the eyelet is 3mm. 

I. Now that you have one perfect eyelet, copy and paste to create two more. 

1. Left click on Select  

2. Right click and select Copy from the pop up menu 

3. Right click and select Paste from the pop up menu 

4. Move the new eyelet into position. 

5. Right click and select Paste from the pop up menu 

6. Position the last berry. 

7. NOTE:  If you would find it helpful to have the original backdrop artwork on the page 
again to help you in positioning the berries 

a) Left click on the bottom of the Backdrop tool  

b) Left click to place a checkmark next to Show Backdrop in the menu 

8. When the berries are positioned, left click the bottom of the Backdrop tool  

a) Left click to remove the checkmark next to Show Backdrop in the menu 

b) You can make the backdrop appear or disappear any time. 

 

VII. Save Eyelet As Quick Pick 

A. Now that you have created a perfect eyelet, you might want to use it again for other 
embroidery designs. 
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    ON THE TOOLS TAB 

1. Select one eyelet 

2. Left click on the Tools tab 

3. Select Save Quick Picks  

4. Give your eyelet a name and save it. 

B. To use your new Quick Pick eyelet 
ON THE HOME TAB 

1. Left click on Quick Pick  

2. The Quick Pick window will open on the right side of the page. 

3. Open the window, scroll down to your eyelet and left click on it. 

a) The Quick Picks are listed in alphabetical order. 

4.  Left click on the design page and an eyelet is created. 

5. Left click again and you will get another eyelet. 

a) Place as many eyelets as you need for your design by simply left clicking for 
each eyelet 

6. Left click on Select  

7. Select each eyelet and click and drag to adjust the position if necessary. 

 

VIII. Sewing Eyelets 
A. Traditionally cutwork is sewn by sewing very short straight stitches 
around the area where the fabric will be removed.  Then the fabric is cut 
away, and finally the raw edge of the cut fabric is covered with a satin 
stitch. 

1. The Appliqué  stitch effect that sews straight 
stitches and then covers the edge with a satin stitch so it can be 
easily used to create the open effects of eyelets.  

B. For eyelets, the ideal way to create the look is to use an awl and a 
cutting mat. 

1. Hoop the fabric and stabilizer 

a) Using water soluble stabilizer will ensure that the 
stabilizer can be completely removed so there won’t be any whiskers of stabilizer 
in the eyelet hole. 

2. Sew the two straight stitch circles that are the first two steps 
of the Appliqué stitch effect. 

3. Remove the embroidery hoop from the machine, but do not 
take the fabric out of the hoop 

a) Use an awl and a cutting board to cut a hole in the 
center of the sewn circle. 
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4. Place the embroidery hoop back on the machine, and sew the satin stitch  

 

IX. Preserve As Stitches  
A. It would be easier if we could sew the straight stitches for all three berries, cut our holes, and 
then sew the satin stitches for all three berries. 

1. The appliqué stitch effect is shown as one line in the Sequence View. 

B. We can use “Preserve as stitches” to separate the straight stitches from the satin stitches so 
they can be sequenced in the order that we prefer. 

1. Note that you want to finish all other editing before you use the Preserve as stitches 
function.  Once you have changed to stitches, some editing functions such as the shape 
tool will no longer work.   

C. Select the Sequence View tab 

1. Select an eyelet berry. 

2. Right click and select Preserve As Stitches from the pop up menu. 

3. Note that the three steps of the appliqué berry are now shown in the Sequence View 
as separate lines. They are listed simply as “Stitches” instead of showing the appliqué 
stitch effect. 

4. Repeat for the other two berries. 

D. Change all of the straight stitches to the same color so the machine will sew them without 
stopping between the first and second round. 

1. Hold down the Control key on the keyboard and select all of the straight stitch rings. 

2. Select the Color Palette tab 

3. Click on purple  in the color palette. 

a) The color used is unimportant as long as it is different than the green in the 
leaves and the rose pink in the eyelet..  

b) The eyelet will be sewn all in one 
color.   

c) The purple will just give a signal to 
the embroidery machine to stop after 
the straight stitches so we can cut our 
hole. 

E. Left click on the Modify tab 

1. Select All Items at the top of the 
Sequence View 

2. Left click on Color Sort  

3. The design now has three colors 

a) The green of the leaves 

b) The purple of the straight stitches 

c) The pink of the berries 

F. The design could be sewn in the soft pastels that we used to create it and it is very pretty 
done that way. 

G. Or now that we have the design sewing in the correct order, we could change the color to sew 
the design all one color for a tone on tone effect. 

1. Select the leaves and their outlines 
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2. Hold down the Control key on the keyboard and select the three satin stitch eyelets  

a) Do not select the purple straight stitch parts of the eyelets 

3. Left click on ecru or cream   in the color palette. 

4. Do not change the color of the purple straight stitch rings.   

a) We need the machine to recognize the color change and stop so that we can 
cut the hole in the center of the eyelet. 

b) You will not want to sew those straight stitches in purple.   

c) Remember that the purple is just used to signal the machine to stop so we can 
cut the holes. 

d) Sew the entire design in the ecru or 
cream that you selected 

H. To sew the holly design 

1. The leaves will sew first 

2. The straight stitch rings will sew second 

3. Cut the holes for the eyelets 

4. Put the hoop back on the machine and 
sew the satin stitch rings  

5. And you have a lovely heirloom tone on 
tone holly design. 

 
X. Easy Scallop  

ON THE HOME TAB 

A. The Holly design can be used alone, or it can be 
used as one element of a coordinating border design. 

B. Open a New  page  

1. Turn on 3D  

C. To create a scallop shape 

1. Left click on Artwork  to open the menu 

2. Select the ellipse  

a) Left click and drag on the design page to draw an ellipse 

b) Do this quickly, since it does not matter what the exact size and shape is that 
you create.   

c) We will adjust it in the next steps to fit our exact requirements. 

3. Left click on the Properties tab at the bottom of the page on the right side of the 
screen 

a) Then left click on the Transform tab at the top of the Properties box at the top 
of the right column. 

b) Remove the checkmark from the Maintain aspect ratio box  

c) Change the width of the circle to 50mm (2 inches) 
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d) Click Apply  

e) The width of the circle is changed to the size needed but the height is not 
changed 

f) Change the height of the circle to 50mm (2 inches) 

g) Click Apply  

h) And now we have a perfect round circle that is exactly the correct size 

(1) When we created the circle for the berries, we used the Control key on 
the keyboard to draw a perfect round circle. 

(2) But if you forgot to hold down Control and your circle is not the shape 
you needed, you now know how to fix it. 

4. Copy and Paste to create a second identical circle. 

a) Select the circle 

b) Right click and select Copy from the pop up menu 

c) Right click and select Paste from the pop up menu 

5. Select the second circle and move it toward the top of the design page so a scallop 
shape is formed between the two circles 

a) Measure the widest part of the scallop shape.  

b) Left click on the Ruler   

c) Click and drag to measure widest part of the scallop. 

d) The scallop should be about 7 or 8mm wide at the 
widest point.   

D. Use Transform Artwork to isolate the scallop shape. 

1. Left click on the Sequence View tab at the bottom right 

2. Select All Items at the top of the Sequence View 

3. Right click and select Transform Artwork 

4. A pop up list opens that includes four different effects that can be applied to our pair of 
circles. 

a) Each of these transform effects will change the pair of circles in a specific 
manner. 

 

5. Try Unite: 

a) Right click and select Transform Artwork  

b) Select Unite from the pop up menu 

c)  The two circles become one shape.   

(1) The outer outline of the circles becomes the shape of the new artwork. 

d) Unite uses the outer outline of the two shapes to create one shape.  

Becomes 
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e) Left click Undo  to return to two circles 

6. Try Intersect: 

a) Select All Items at the top of the Sequence View 

b) Right click and select Transform Artwork  

c) Select Intersect from the pop up menu 

d) The cat’s eye shape where the two circles overlap in the center becomes the 
shape of the new artwork 

e) Intersect uses only the area covered by both shapes to create the new shape 

f) Left click Undo  to return to two circles 

7. Try Clip 

a) Select All Items at the top of the Sequence View 

b) Right click and select Transform Artwork. 

c) Select Clip from the pop up menu 
 

d) The outline of the first circle is removed where it crosses through the second 
circle. 

e) Use Clip when you want to eliminate stray outlines on overlapping shapes.  

f) Left click Undo  to return to two circles 

8. The effect we need to create our scallop is Exclude. 

a) Select All Items at the top of the Sequence View 

b) Right click and select Transform Artwork. 
  

Becomes 

Becomes 
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c) Select Exclude from the pop up menu 
 

9. To see what has happened with this effect, we will need to look at it in the Sequence 
View 

a) Left click on the plus sign 
to the left of the artwork in the 
Sequence View 

b) You will be able to see in 
the Sequence View that two 
scallops have been created. 

c) Exclude has excluded all 
of the areas shared by the 
two circles and left the two 
scallop shapes where the 
artwork did not overlap. 

10. Select the scallop that is upside 
down and touch Delete on the keyboard. 

E. Apply satin stitches to the scallop shape 

1. Select the remaining scallop shape 

2. Left click on  to open the menu 

3. Select Auto  

4. Left click on the color chip to  change the 

color to ecru  

5. New in MasterWorks III, set the traveling 
path in Properties 

a) Left click on Zoom to Fit  

b) You can see traveling run stitches 
along the edge of the satin stitch 

c) Left click on the Property box tab in 
the lower right corner of the page 

d) Open the Traveling Route window 
and select Along Edge 

e) Left click Apply  

Becomes 
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f) And the traveling stitches are now safely hidden under the satin stitching and 
we have a beautiful scallop. 

 
XI. Assemble Holly Border 

ON THE TOOLS TAB  

A. Save the scallop as a Quick Pick   

1. Select the scallop 

2. Left click on the Tools tab 

3. Select Save Quick Picks  

4. Give your scallop a name and save it. 

B. To add scallops to your holly design 
ON THE HOME TAB 

1. Return to the design page with the holly design 

2. Select All Items at the top of the Sequence View 

3. Right click and select Group from the pop up menu 

C. To use your new Quick Pick scallop 

1. Left click on Quick Pick  

2. The Quick Pick window will open on the right side of the page. 

3. Open the window, scroll down to your scallop 
and left click on it. 

a) The Quick Picks are listed in 
alphabetical order. 

4.  Left click on the design page and a scallop is 
created. 

5. Left click again and you will get second 
scallop. 

6. Left click on Select  

7. Select each scallop and click and drag to adjust the position if necessary. 

C. Set start and stop points for scallops 

1. Select the scallop on the left 

2. Left click on the Reform  

3. Move the green start dot to the left end of the scallop, and move the red stop dot to 
the right end.   

a) Note: any time you cannot see the green dot it will be under the red dot.  Click 
and drag on the red dot and you will pull the green dot out from under the red dot. 

4. Click Apply  

5. Select the right scallop and repeat. 

D. Align the scallops 
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ON THE MODIFY TAB 

1. Left click on the Modify tab 

2. Left click on Select  

3. Select the two scallops 

a) Left click on the scallop on the left to select it 

b) Hold down the Control key on your keyboard 

c) Left click on the scallop on the right 

4. Select  Align Bottom  

E. Group the scallops 
ON THE HOME TAB 

1. While the two scallops are still selected 

2. Right click and select Group from the pop up menu 

F. Group the entire design 

1. Left click on All Items at the top of the Sequence View 

2. Right click and select Group from the pop up menu 

3. Grouping the design will allow you to select and move the design without accidentally 
changing the position of the various parts of the design. 

G. Add a hoop to the design page 

1. Left click on Hoop  

a) The hoop you selected last time will be displayed on the design page 

b) If this is not the hoop you wanted to use, left click on the arrow at the bottom of 

the Hoop icon  to open the menu 

c) Left click on Select Hoop in the menu 

2. Select the 200 x 300 hoop and place a checkmark in the box labeled Rotate 90

 
a) The hoop sizes are all given in millimeters on the list of hoops, and are actually 
the size of the embroidery field rather than the size of the hoop. 

b) If your program preferences are set to English for inches, the measurement in 
inches of the selected hoop area will be shown just above Apply in the lower right 
corner of the box. 

3. Click OK and the hoop box is closed. 

a) The holly embroidery design is centered in the hoop. 

H. Copy and Paste to create additional holly designs 

1. Left click on All Items at the top of the Sequence View if the design is not already 
selected. 

2. Right click and  select Copy from the pop up menu 

3. Right click and select Paste from the pop up menu 

4. Move the second design into position on the right so the scallops just touch. 

I. Line up the two holly designs 
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1. If desired, zoom in on the points of the scallops where the two designs meet. 

a) Left click on Zoom  

b) Left click and drag a box around the area where the two scallops touch 

2. To fine tune the position of the scallops 

a) Hold down the Control key on the keyboard 

b) Use the cursor arrows on the keyboard to move the scallop on the right into the 
correct position 

c) This will allow you to “scoot” the design in tiny increments until it is just where 
you want it. 

J. Make sure that your border won’t sew up or down hill 
ON THE MODIFY TAB 

1. Select All Items at the top of the Sequence View 

2. Left click Center  to move the design to the center of the hoop 

3. Left click on Align Bottom   

K. If there is room in your hoop, you could repeat the steps above to add a third repeat to your 
border 

ON THE HOME TAB 

1. If adding a third design makes it a little bit too big for your hoop you can use Fit Hoop 
to adjust it to the largest size that can be sewn in the hoop you have selected 

2. Left click on the bottom of the Hoop icon  to open the menu 

3. Left click on Fit Hoop  
 

XVII. Last Sequence Check 

A. Although we were very careful to sequence the leaves and berries of the holly design for the 
easiest sewing, we sort of skipped over that step with the scallops 

1. It is not too late to look at how the border scallops will sew 

B. If you select the first scallop on the left, the whole holly design is selected because we 
grouped it 

1. Select All Items 

2. Right click and select Ungroup from the pop up menu 

C. Select the first scallop on the left 

1. Left click on the Reform tool  to check the green start point and the red stop 
point. 

2. If the green start point is not visible, where it will be is under the red stop point 

3. Click and drag the dot and you will always get the green start point first if the two 
beads are in the same place.  
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4. Move the green start point to the left tip of the scallop so the scallop will sew left to 
right. 

5. Right click on the background of the design page to apply the change 

6. Left click on the Select tool  

7. Right click and select Move and slide sideways to select Last from the pop up menu 

D. Select each scallop in turn moving from left to right and make the same changes you made 
on the first scallop at the left 

1. Note that when you move the second scallop to Last it will be sewn after the first 
scallop. 

E. Do one last color sort so all of the purple straight stitches sew at the same time, and you will 
be able to cut out all of the holes at the same time. 

ON THE MODIFY TAB 

1. Left click on the Modify tab 

2. Left click on All Items at the top of the Sequence View 

3. Left click Color Sort  

a) The leaves and scallops sew first 

b) All of the purple straight stitches sew second 

(1) Remember that you will not really sew them with purple thread 

(2) Use the same thread for the entire design 

(3) The purple color is just used to make the machine stop sewing so we 
can cut the eyelet holes. 

c) Cut the eyelet holes 

d) Embroider satin stitches around the berries 
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Companion Selling Products for this Sew at Home 
 

Sew at Home classes 
Madiera Embroidery thread 40 wt 
Baby Lock Disolve-Away Mesh Stabilizer   #BLS500 
Or Baby Lock Rinse-Away Tear-Away   #BLT110 
Embroidery needles size 75/11 
Finishing Touch Bobbin Thread 
Gingher 4 inch curved scissors    #G-4C for trimming embroidery threads 
Gingher 5 inch sewing scissors    #G-5 for trimming applique fabric 
Upgrade to MasterWorks III 

 


